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April has been a whirlwind of activity for CCRA.  With the budget crisis looming, CCRA has been
working diligently to protect the integrity of the profession.  Our DR Task Force has logged in
hundreds of hours.  CCRA’s members have responded with overwhelming support by
volunteering their time, donating money to the special fund, and gathering information. 

Our statewide Action Team, made up of members from each county, stepped up and gathered the
necessary DR information we needed from each county, enabling CCRA to have up-to-date
information at our fingertips for testimony before the legislature.  A big high five goes to Carlos

Martinez, Sonoma County, who jumped in and rescued my weary brain when we needed immediate information
from each county. 

Doreen Perkins, Fresno County, cochair of the DR Task Force, worked very closely with Chris Crawford, of
Justice Served, first ensuring he had all the necessary information to formulate his independent analysis of the
viability of digital recording in California courts, and, secondly, gathering the information for his analysis of the
ownership of transcripts in California — all while keeping up with her regular trial court duties, I might add!

Tom Pringle, Shasta County, cochair of the DR Task Force, spent countless hours devouring every report and
every bit of information we could find on DR throughout the country.   Tom is a true visionary, and has the unique
ability to see past any situation and formulate consequences for actions that no one else has even thought of.

Arnella Sims, LA County, also on our DR Task Force, truly helped to guide the whole team in the right direction
with her wealth of information from the 70’s to the present. She remembers EVERYTHING!  Not only does she
remember it, she has the written documentation to back it up.  I guess she never throws anything away.  It really
came in handy.

Having such a stellar team behind a president is a dream come true.  When it came time to testify before the
legislature, I knew I had an entire team of knowledge behind me.  Preparations in advance made all the
difference.  Was I nervous?  You betcha!   But with a team like this behind me, I was confident we could turn this
thing around.

None of this work can be done without the response CCRA has received from you, our members.  The response
has been overwhelming.   Donations, large and small, have poured in.  This is a very expensive project.
Thankfully, CCRA has been able to meet the challenge of financing such a large project.

Not only the officials on our board, but the freelancers on our board — Lynden Glover, Sheri Turner, Judith
Gillespie and Sandy Bunch VanderPol — all had a pivotal role in lobbying the legislators we targeted, going to
the legislators’ home offices and their Sacramento offices, explaining our situation, distributing the various
reports from Justice Served, answering the questions from staff.  

I speak for all the official reporters of California when I say we are truly grateful for the freelance reporters
throughout the state who saw that this is NOT a problem affecting only officials, and responded by meeting with
legislators, gathering information, distributing information, and donating to the Special Fund.

Last, but not least, I need to thank my fellow court reporters in Tulare County, who have literally taken over my
court duties on a daily basis, allowing me the time necessary to handle the problems at hand, covering my
court, running my errands, transcribing legislative hearings, bringing me food, and donating to the Special
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Fund.  I could not even imagine trying to be in trial and dealing with this crisis at the same time.  (Oh, yeah, my
hubby is getting pretty good at the shopping, cleaning, laundry, and cooking.)

Now we’re in a “wait and see” pattern.  The groundwork has been laid, now we wait.  
We will keep you apprised of any new developments as soon as we learn of them.

California Court Reporters Board 
announces a new toll free number

877-3ASKCRB  or
877-327-5272....
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CCRA’s Legislative Efforts —
A Month in Review

By Sandy Bunch VanderPol, CCRA Legislative Advisor
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CCRA’s legislative efforts this past month have been
focused on the two budget subcommittee hearings
as relates to the Legislative Analyst’s Office
proposed budget that included a phaseout of the
stenographic reporter over the next five years.
However, this focus was not to the detriment of the
other bills CCRA is sponsoring, supporting or
watching.  It’s those efforts that I would like to
summarize for you.  

Rather than reciting the specific language of what
each of the bills summarized below does, please see
the legislative report for the relevant language that
affects our profession.  This can be found in each
month’s CCRA Online and on our Web site.

AB 2884 (Portantino) is a bill sponsored by CCRA.
This bill has been amended with agreement and
support of the Administrative Office of the Courts
(AOC), and clarifies that the official reporter or official
pro tempore reporter’s “Instant Visual Display” (also
known and referred to as realtime reporting) cannot
be certified and cannot be used, cited or transcribed
as the official transcript of the proceedings.  The
“Instant Visual Display” of the proceedings shall not
be used to rebut and/or contradict the official
certified transcript of the proceedings.  This bill is
currently awaiting a vote on the Assembly floor after
moving out of the Assembly Judiciary on the consent
calendar on April 23.  At the request of the AOC,
CCRA provided a background paper on this bill.  We
have also sent a sponsor letter to the Assembly
Judiciary Committee.  You can find both of these
documents on CCRA’s Web site under “Legislation.”

AB 1925 (Eng) is a bill that your CCRA board felt
strongly over-reached its intended purpose.  Our
lobbyist has weighed in with the author’s office that
CCRA is concerned with this bill, especially as it
suspends your CSR license if you owe taxes to the
Franchise Tax Board.  The author’s intent and
rationale for this bill is to reach the vocations and
professions that work on a cash basis and address
the tax issue in their *that* regard.  However, this bill
does not specify that, but included all licensees of
vocations and professions.  As of a few days ago, the
bill was amended to grant a delinquent taxpayer the

opportunity for an additional hearing for financial
hardship prior to the suspension of a professional or
occupational license.  I would just add that by no
means does CCRA condone the practice of
nonpayment of taxes.  Our concern was that there
was suspension of your license without the
opportunity to show that suspension would create a
financial hardship.  This bill in its current form will not
be opposed by CCRA.

AB 2189 (Karnette) is a bill sponsored by the Court
Reporters Board. CCRA was the association that
obtained an author for this bill through the efforts of
your lobbyist.  CCRA supports the Court Reporters
Board in their efforts to obtain mandatory continuing
education.  I personally was in attendance when
Assemblymember Karnette presented the bill on the
Assembly floor.  The bill passed the floor on a vote of
Y:46 N:26 A:8.  CCRA has written a letter in support
of this bill.  You may find that letter posted on our
Web site under “Legislation.”

AB 1545, AB 3037, AB 1869 and SB 797 are all bills
that CCRA is tracking very closely.  Each of these
bills relates to the sunsetting of the Court Reporters
Board, the Executive Director position, and/or the
abolishment of the CRB.  As recently as April 25, SB
797 was amended to extend the sunset date of the
executive officer of the Court Reporters Board until
January 1, 2012.  These bills also affect other
consumer boards.

SB 1490 (Padilla) and SB 1583 (Corbett) are bills that
you, as a deposition reporter and/or firm owner, will
need to be aware of should they pass through the
legislature.  CCRA is tracking these bills and will
keep you updated if they are amended.  Generally
speaking, each applies to the treatment of
independent contractors, paperwork you must
maintain, et cetera.  Again, please see the CCRA
legislative report for a long summary of these bills.

As you can see, CCRA is using your member dollars
to represent the profession in a very diligent way in
the legislature.  We thank you for your membership
and support in this regard.



On April 23, representatives from CCRA’s DR Task
Force and CCRA Board of Directors attended the
Assembly Budget Subcommittee meeting in
Sacramento and testified in opposition to the
Legislative Analyst Office’s (LAO’s) budget proposal
for DR in California courtrooms and the
Administrative Office of the Courts’ (AOC) assertion
(at the Senate budget subcommittee hearing on April
9th) that shifting of “ownership” of the transcript from
the reporter to the court would result in cost savings.
(Video link below)

At the April 23 hearing, the AOC did not put forth
shifting “ownership” of the transcript, nor did they
suggest that juvenile and family law hearings be
electronically recorded.  However, the LAO has now
added shifting of “ownership” of the transcript and
replacing court reporters in juvenile and family law
proceedings into their proposal. 

The AOC was once again complementary to court
reporters in general, indicating our realtime skills
having progressed dramatically in the last decade,
resulting in a substantial benefit to the courts, while
electronic recording essentially has not.

In response to the proposal for shifting of
“ownership,” CCRA commissioned a report by
Justice Served, entitled Cost Implications of State
“Ownership” of the Verbatim Record,   Click Here:
http://www.cal-ccra.org/documents/Crawford-
TranscriptOwnershipFinal.pdf for distribution to the
legislature, refuting the cost savings to the court.  

The report findings are as follows:
(1) Court reporters work as independent contractors

and this privatized arrangement results in a cost
savings to the court; 

(2) The courts are currently paying 18-year-old fees
to court reporters for transcription.  Court
reporters are able to continue producing
transcripts at these rates because of privately-
funded efficiencies that will cease to exist if the
state “owns” the record; 

(3) Court reporters currently bear all direct and
overhead costs for transcription, including

investments in technology.  These costs will shift
to the state and result in higher costs. 

“In short, shifting ownership of the court record
from the court reporter to the court does not
provide hard cost savings, and results in
substantial negative consequences that impact
its accuracy, timeliness and integrity.”

CCRA once again presented to the committee the
independent analysis of digital recording entitled Digital
Reporting in the California Courts, prepared by Justice
Served, http://www.cal-ccra.org/CrawfordAnalysis.pdf
pointing out the fallacies that DR is more efficient and
cost effective.

As part of our strategic plan, CCRA once again met
with the legislators on the committee, setting forth
our position and distributing the information before
the hearing.  Having done our homework in advance,
the legislators on the committee asked some very
pointed questions of the LAO and AOC.  CCRA was
able to refute many of the points made by the LAO in
our testimony before the committee.  The April 23rd
hearing was “informational” only; therefore, no
formal action was taken.  

The highlight of the day came after CCRA’s
opposition testimony. Assemblymember Sandre
Swanson (D-Oakland) stated, “I think court
reporters are awesome.”

CCRA has laid a very good groundwork to the
legislature and we’re hoping for a positive result.
We now wait and see what is included in the
Governor’s May revised budget, called the May
Revise.  This will occur in about the third week of
May.  Watch for important updated information and
visit the CCRA Web site often for updated
information. www.cal-ccra.org

The response by our members to CCRA’s Call to
Action has been impressive.  Donations to the
Special Fund continue to come in.  Because CCRA
represents both freelance and official reporters, we
have the unique ability to address a broad spectrum

Assembly Budget Hearing Update

By Lesia J. Mervin, CSR #4753, RMR, CRR
CCRA President
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of issues and utilize the strength of the entire
profession.  Our freelance members have recognized
this is not just an issue affecting official reporters.  A
big thank you to our freelance members who have
stepped up and taken action in a big way to help
their fellow official reporters by meeting with
legislators, gathering information, distributing
information, and donating to the special fund.

Video link:
http://www.calchannel.com/MEDIA/0423F.asx

Issue #4 Electronic Court Reporting
TIME CLOCK
BEGIN END SPEAKER
2:13:54 2:16:55 LAO
2:16:55 2:19:48 William Vickrey, 

Executive Director of the Courts

2:20:52 2:21:33 Chuck DeVore, 
Assemblymember

2:21:35 2:23:22 William Vickrey, 
Executive Director of the Courts

2:23:26 2:25:55 Gene Mullin, 
Assemblymember

2:26:20 2:26:50 LAO
2:26:52 2:27:25 William Vickrey, 

Executive Director of the Courts
2:27:35 2:32:10 Lesia Mervin, President CCRA
2:32:15 2:32:22 Sandre Swanson, 

Assemblymember
“Court Reporters are 
Awesome”

Assembly Budget Hearing Update
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A compound adjective is two or more words that form one unit to modify a noun or pronoun. It might be one word,
hyphenated, or two words. It is important to check a standard dictionary for a compound adjective form to see
whether it is one word. However, when you find a compound adjective hyphenated in the dictionary, you are going
to have to know a little more about how that adjective is being used before you decide to hyphenate it. 

When two or more words form one unit in front of a noun, they are hyphenated.

We installed wall-to-wall carpeting.
That was not part of our long-range plans.
It was a two-lane highway in each direction.

To check to see whether the words form a unit, use the words individually in front of the noun. If each word
modifies separately and makes sense, then the words do not form a unit, and no hyphen should be used. 

big green bug big bug green bug

Since it is both a big bug and a green bug, the combination in front of the noun is not hyphenated: big green bug

two door automobile two automobile door automobile

Since it is neither a two automobile not a door automobile, the combination in front of the noun is hyphenated:
two-door automobile

Remember that the words should make sense as a unit if you are going to hyphenate them. For example, the
phrase “sunny breakfast room,” sunny and breakfast do not take a hyphen because there is no such thing as a
“sunny breakfast.”

If the adjective combination is not in front of the noun modified, it is usually NOT hyphenated.

He has long-range plans.
His plans are long range.

He is a nice-looking and well-mannered young man.
The young man, nice looking and well mannered, helped us with the problem.

If two (or more) words are recognized as a unit already, there is no need to hyphenate them as they already form
a unit. This is the case with all two-word compound nouns.

income tax social security high school
senior citizen real estate credit card
due diligence genital herpes general admission

Since these words are found in the dictionary as compound nouns, which means they are already thought of as
a unit, AND they are already two words, they remain two words wherever they appear including when they are
adjectives in front of a noun.

income tax payment social security check high school graduation
senior citizen event real estate transaction credit card debt
due diligence process genital herpes outbreak general admission ticket

Hyphenating Compound Adjectives
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By Margie Wakeman-Wells



On April 9, representatives from CCRA’s DR Task
Force, CCRA President Lesia Mervin and CCRA past
president Tom Pringle, testified before the Senate
Budget Subcommittee meeting in regards to the
Legislative Analyst Office’s (LAO’s) budget proposal
for DR in California courtrooms. 

Prior to the meeting, our team had set in motion a
strategic plan that included meeting with these
subcommittee members in their local offices.
Included in the information distributed to the
committee was a report commissioned by CCRA
providing an independent analysis of digital reporting
in the California courts, prepared by Chris Crawford
of Justice Served.

The Crawford Report pointed out many of the
fallacies that DR is more efficient and cost effective,
including the loss of the  $26 million civil user-fee
revenue the courts charge for the use of a court
reporter in civil hearings; loss of $11 million in civil
court reporter filing fees; accuracy and integrity of
the record; and the myth that reviewing DR files, in
lieu of the written word, would be more efficient.

A representative from the Administrative Office of the
Courts (AOC), including Executive Director William
Vickery, made representations at the meeting outlining
the AOC’s desire to maintain reporters in all felony trial
matters, stating, in part: “realtime reporting has
improved significantly and has been a major asset
to the justice system, I would urge felony trial
matters be excluded from the discussion.”

Mr. Vickery further indicated that no cost savings
could be achieved by replacing reporters with DR in
civil courts due to the civil court reporter user fee and
filing fee charged to the litigants that pay the costs for
reporters in civil courts; however, it was his opinion
“cost savings could be achieved by replacing
reporters in juvenile and family law matters.”

The next area where the AOC believes they can
achieve cost savings is ownership of the record. “If
the state owns [the transcript], then you have to pay
the reporter to prepare it on state time, but there
probably is some savings there.  I think that’s a
different policy issue than the policy decision to

eliminate court reporting in
total from the court
system.”

The budget committee
voted to “hold
open” the item for
further discussion
pending further
information.  

CCRA’s task force
will be working
diligently to gather
the information
necessary to rebut
the assertion that a
cost savings could
be achieved by
taking ownership of
the record away
from the reporters,
and the assertion
that family law and
juvenile reporters
are not a necessary
function of the
court system. 

Watch the ER page of CCRA’s Web site often to stay
updated on the progress of this issue.  

A big “thank you” goes to all of you who have
participated at the grassroots level by meeting with
their legislators in their local offices, and thanks also
to those that have been so generous in your
donations to the Special Fund!  Keep those
donations coming!  To donate, click here.

To view the full video of the proceedings click here.
LAO testimony starts at 59:00
Vickery testimony starts at 1:02
CCRA Testimony starts at 2:06

To view the entire transcript, click here.

Digital Recording Update 
Senate Budget Subcommittee Meeting
By Lesia J. Mervin, CSR #4753, RMR, CRR
CCRA President
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There’s been a lot of talk this past year about
“refreshable” realtime and who offers it, how to do it,
and what’s the best setup.  The reality is that if you
are on the latest Eclipse software, you can take
“Advantage” of their Bridge realtime browser which
allows for instantly auto-refreshable realtime — and
it’s FREE.  The Bridge software is tokenless and is
compatible with all CAT systems.  I’ve used the
Bridge software with Stenocat via a simple WLAN
(wireless local area network) and it’s awesome.
Clients hook up just by logging into my network via
their wireless laptop.  Did I already say it’s FREE?  Oh,
and it runs off of a thumb drive as well.  Pure genius.  
More Info

On a side note, Advantage Software offers the open-
source refresh code to ALL CAT vendors at no
charge to implement into their CAT systems.  This
would make my Stenocat and your anyCAT realtime
feed auto-refreshable on a FREE, tokenless, realtime
browser — not to mention the wireless capability! 

Denoto from Procat offers the same ability to refresh
the realtime feed via a “refresh” command, but the
refreshability is proprietary to Procat Winner users.
It’ll cost you about $295/copy.  This is also a
tokenless realtime browser, works via a WLAN, and it
is compatible with all CAT systems. 
More Info

Another proprietary realtime browser is CaseviewNet
from Stenograph.  CaseviewNet has a lot of great
security and end-user features.  This software is
tokenless and provides auto-refresh to all
CaseCATalyst users.  CaseviewNet is not compatible
with any other CAT system.  Like the others, it also
works over a WLAN, but it will set you back
$595/year to use it.
More Info

Have a question or product suggestion?  
Email me eric@depobook.com.

The Gadget Guy

Eric Johnson, CSR, RPR Eric Johnson is owner of Depobook Court Reporting Services and
Depobook Court Reporting Products, located in Modesto, California.
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THE PERFECT DIABETIC CASSEROLE
There are so many of us who either are or know someone who is diabetic. I thought it
would be helpful to share this great discovery.

CHICKEN CASSEROLE

Preheat oven to 375.  In a frying pan, heat oil over medium heat.  Add celery,
carrots, onion, garlic, salt, pepper and basil.  Cook about 5 minutes.  In a large bowl,
combine chicken, sour cream, buttermilk, mayo, wine, almonds and sautéed veggies.
Mix well and spoon into a 2-quart sprayed casserole dish.  Combine breadcrumbs and
Parmesan cheese and sprinkle over the top. Sprinkle with paprika.  Bake 30 minutes,
until lightly browned on top.  If you are concerned about calories, low fat or non-fat
dairy products may be substituted.

2 Tbsp. olive oil
4 celery ribs, chopped
2 medium carrots, finely chopped
1 small onion, finely chopped
2 cloves garlic, minced
1 tsp. salt
Freshly ground pepper to taste
1 tsp. basil
3 c. cooked chicken, coarsely chopped

1/2 c. sour cream 
1/2 c. buttermilk
1 c. mayonnaise 
1/4 c. sherry
1 c. coarsely chopped roasted almonds
1/4 c. breadcrumbs
1/4 c. Parmesan cheese
Paprika

Cal-e-licious
By Gerie Bunch

http://www.accucap.com/?q=node/2167
http://procat.com/LitSup/Denot-Intro.html
http://www.stenograph.com/pages.aspx?docid=380
mailto:eric@depobook.com


Executive Summary
This report examines the cost implications of state “ownership” of the verbatim record in California courts. The
reason this examination is necessary is that the state is facing a substantial budget deficit, and one of the cost-
saving recommendations from the state Legislative Analyst’s Office (LAO) is to convert verbatim record
methodology from stenographic court reporting to digital recording. 

At the initial budget hearings, the state Administrative Office of the Courts disagreed with the LAO’s projected
cost savings because civil court reporting services and transcript production costs are borne by the litigants, and
because of productivity benefits derived from the computer aided court reporting “Realtime” record (especially
in criminal proceedings). The attention has now shifted to prospective cost savings attributable to state
“ownership” of the verbatim record, ostensibly to reduce transcript production costs.

Findings
We conclude that the California courts will not achieve cost savings by state “ownership” of the verbatim record
for three primary reasons:

1. Court reporters currently produce transcripts as independent contractors, and this privatized arrangement
results in cost savings that cannot be achieved if the courts assumed this responsibility.

2. The court is currently paying 18-year-old transcript production fees to court reporters as provided by
statute. Court reporters are able to continue producing transcripts at these rates because of privately-
funded efficiencies that will cease to exist if the state “owns” the record. When the court pays salary and
overtime, and/or seeks outside contractors to perform this work, transcript production costs will be higher. 

3. As independent contractors, court reporters currently bear all direct and overhead costs associated with
producing and delivering transcripts, including investments in technology. These costs would be shifted to
the state, resulting in added higher cost and delay.

These findings are covered in more detail in the remainder of this report.

How Transcripts are Produced
When preparing transcripts, official court reporters in California courts act as independent contractors, bear all
production costs, and work mostly after hours and on weekends. These court-reporter-paid costs include
personal labor for production, purchasing and use of computerized technology, purchasing of supplies, hiring of
support personnel, and delivery. When the court orders a transcript, it is filed within the court-directed or
statutory time requirements. 

Cost Implications of State “Ownership”
of the Verbatim Record in California
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The California courts cannot possibly achieve the free-market efficiencies in terms of timeliness and cost for
production that court reporters produce as private contractors working on a profit incentive. If the state “owned” the
record, court reporters would have to be paid straight salary to produce transcripts during an eight-hour workday,
the vast majority of which is currently filled capturing the record in the courtroom. The result would be either (a)
payment of overtime to existing court reporting staff; (b) hiring of additional court reporting staff; (c) hiring of
transcription staff; or (d) a combination, all of which will increase the cost and time needed to produce transcripts.

It is important to note that the court does not currently pay overtime to court reporters because after-hours time
spent producing transcripts is performed by the reporter as a private contractor. This public/private employment
relationship is unique to the official court reporting profession and rarely found elsewhere.  It is recognized by U.S.
statute in the Fair Labor Standards Act, which was amended in 1995 to allow this unique “privatization” and relieves
the courts from having to pay overtime for work demands that easily exceed 40 hours per week.

Like other professions, court reporting has been dramatically affected by technology.  However, what sets court
reporters apart are two distinctions:  First, these technologies are privately funded by individual court reporters
at no expense to the courts they serve; and, second, court reporters have been “early adopters” of technology
for the past 25 years — much earlier than a vast majority of the courts they serve. Currently, over 98% of court
reporters in California use Computer Aided Transcription (CAT) for reporting and preparing transcripts of
proceedings.  Transcripts prepared by court reporters are backed up for redundancy, significantly reducing
instances of lost records, and they are capable of storage in Web repositories for wider accessibility.

The reason for this phenomenon is simple. In their role as private contractors producing transcripts, official court
reporters are highly motivated to improve productivity.  Investing in and developing technology are business
necessities driven by a free market incentive.  The side benefits to the courts, lawyers, and litigants are
impressive.  CAT technology not only helps the court reporter to quickly produce a transcript, but proficient court
reporters are able to simultaneously create and display a rough draft of the verbatim record at the time the
proceedings occur. This feat is called Realtime reporting that judges, attorneys, litigants, and others are quickly
learning to use to improve their own productivity. This instant display and text file of the spoken word allows
judges, lawyers, clerks, interpreters, and others to add notes and annotations for current or later needs.

By changing the nature of their “product” from a paper transcript to a digital file, court reporters have provided
several additional opportunities for cost savings and improved productivity by the court and its users.

Privately Financed Court Reporter Transcription Costs
Unlike most California public employees, court reporters must personally pay for a wide variety of technology,
and even staffing, in order to perform their dual role of court employee, to capture the verbatim record, and
private contractor, to produce transcripts. The California Government Code sections 70311 (a) and (b), and
70313 prohibit the courts from supplying stenotype equipment, transcription equipment, and related supplies to
court reporters. 

These annual and start-up costs are as high as $23,000 or more for technology, equipment and supplies, and
could run as high as $15,000, $20,000 to $30,000 or more for staffing. The choice to hire transcript production
staff differs from reporter to reporter, and the decision is largely driven by the amount of transcript workload.  A
reporter could decide to hire only a scopist (editor of stenographic notes), only a proofreader, both or neither. There
is no choice when it comes to technology, equipment and supplies — these are necessary and ongoing costs. 

Cost Implications of State “Ownership”
of the Verbatim Record in California
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Accordingly, court reporters have made a significant investment in technology and productivity, which benefits
the court in the form of low-cost and rapid transcript production. For instance, in the last 100 years, court-paid
transcript reimbursement costs have increased only 325% for original and 50% for copies, while the consumer
price index during this period has increased 2,000%.  Court reporters have not received any increase in
transcript fees in 18 years.

A detailed breakdown of court reporter-paid costs is provided below:

STAFF COSTS
Annual Volume of Transcript Production Scopist Proofreader 

(85¢ per page) (40¢ per page)

1,000 pages $850 per year $400 per year

5,000 pages $4,250 per year $2,000 per year

10,000 pages $8,500 per year $4,000 per year

25,000 pages $21,250 per year $10,000 per year

NOTE: The decision as to whether to hire a scopist (editor of stenographic notes) and/or a
proofreader is optional and differs from reporter to reporter, and the decision is largely workload
driven.

EQUIPMENT AND SUPPLY COSTS
Hardware, Software, Supplies, Etc. Initial Cost Annual Cost
(replacement cycle indicated in parentheses)

Software: Transcript prep & billing (3-4 years) $4,100
Hardware: Stenotype machine (5 yrs), laptop & desktop computers $10,180 $3,000 
(3-4 yrs), two printers (4-5 yrs), photocopier (leased), 
fax machine (5 years)
Supplies: Copy paper (13 boxes X $30), stenotype ribbons ($15 x 3), $420 $1,665
carrying case (7 yrs), printer toner ($80 x 3), cables, serial converter, 
connectors (5 yrs), fax toner ($35 X 4), binding equipment & 
supplies (6 boxes/yr @ $40 per 100+shipping), office supplies, 
“original” & “copy” stamps, packaging material, diskettes, 
address labels, research material, business cards, CDs.
Other: Stenotype machine (annual maintenance, support for $570 $3,397
software, including updates), Internet provider, wheeler (5 yrs), 
home office furniture (5 yrs), training/seminars, training/vendor, 
postage, professional dues, CSR license, equipment insurance, 
cell phone, liability insurance.

Investment in equipment and supplies $15,270
Annual ongoing costs $  8,062
Combined costs (start-up and annual) $23,332
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California Reporting of the Record Task Force (RRTF) 
In April 2002, the California Judicial Council created a Reporting of the Record Task Force (RRTF) to examine
how court reporting services are provided. Their final report and recommendations were published in February,
2005.  Among their charges was to consider state “ownership” of transcripts and related products. 

After considering all the productivity and cost implications, the RRTF did not recommend that the courts take
over responsibility for producing transcripts, and specifically recommended that court reporters continue to be
paid as independent contractors for this purpose.  Ironically, most of the cost-saving recommendations that
resulted from the RRTF report are directly attributable to the technological advances that court reporters have
privately funded to convert the verbatim record into a digital format, which is three to five times faster to review
and can be easily stored, retrieved, transmitted, shared, and more productively used by judges, attorneys,
litigants and court staff.

The Unquantifiable
While it is important to present accurate cost figures as we have done in this analysis of the financial impact of
shifting ownership of the record from the court reporters to the court, there are also a substantial number of
unquantifiable negative consequences for doing so. 

The Electronic Recording Project Advisory Committee asked in their 1992 final report:  “Who is in charge of
making the record?  Is there a chain of players and equipment, or one individual who is responsible and
accountable for accuracy and the integrity of the record.” A court reporter is currently the central figure in charge
of the record.  When the responsibility for the record is shared among several parties, such as a court monitor,
court clerks and court management, chances for errors and delay increase precipitously. 

Since the Electronic Recording Project and its final report form the primary basis for the LAO’s recommendations,
several other observations from that report are worth repeating:

“An orderly system of justice requires an accurate and timely record for appellate review.”

“Audio reporting is an acceptable method in all courts which do not have testimony if there is a trained
monitor who has no other duties while recording.”

“We found inconsistency in quality of audio transcripts.”

“A computer integrated (court reporter) and video reporting system (are) the state of the art. It promises
a trial with a near instant record.”

“Courts should be open to technological advances.”

In short, shifting ownership of the court record from the court reporter to the court does not provide hard cost
savings, and results in substantial negative consequences that impact its accuracy, timeliness and integrity.

This report was prepared by Chris Crawford, president of JUSTICE SERVED®, a court management and
technology-consulting firm. Mr. Crawford has more than 34 years of court management experience, including 21
years managing California trial courts. For more information, please visit www.justiceserved.com.
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The Nominating Committee of CCRA is in the process
of selecting qualified candidates for service as officers
and members of the Board of Directors for 2008-2009. 

Each year, half of the positions on the Board of
Directors of CCRA expire.  Nominations are
accepted each spring to fill the following vacant
positions:  District A, Northern California; District C,
Central Valley; and an at large position.  

May 30 is the deadline for nominations for the
2008-09 CCRA Board of Directors. 

Do you know someone you feel would be an asset to
the leadership of your profession? Have your life
circumstances changed and you now find a little
extra time to give back to the profession that’s been
so good to you?  If so, please nominate yourself or a
respected colleague.  But don’t delay!  The deadline
is fast approaching.

Go to: www.cal-ccra.org/boardnominations.htm for
the nomination form.

As an active CCRA member, you have a special
understanding of the qualities of leadership which
candidates for CCRA office should possess.  You have

the opportunity to assess their character and to
determine in your own mind those who possess the
leadership capabilities which are so necessary to the
administration of CCRA and to the court reporting
profession as a whole.

The Nominating Committee hopes you will consider
it your personal responsibility to participate in our
nominating procedures by submitting names of
candidates for consideration by the Nominating
Committee.  Please state the reasons for your
recommendation of each candidate.

Candidates will be contacted by CCRA regarding their
willingness to serve.  Your recommendation should be
received by CCRA headquarters by May 30, 2008.

Go to: www.cal-ccra.org/boardnominations.htm for
the nomination form.

This is a very
important matter,
so please give it
your attention. 

CCRA Needs a Few More Great Leaders to Come Forward!
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Create Your Own Newspaper

Q. I’m a news junkie and though many sites
permit me to customize the type of news I
want, I was wondering if there is any way to
pull together news from various sources so I
can just go to one place and see my favorite
news items?

A. One of the oldest news sites on the Web is one
that does permit you to do that in a clever way,
and for free. The site is called CRAYON
(www.crayon.net). The name is an acronym
derived from CReAte Your Own Newspaper.
After registering on the site, go to Your Paper’s
Settings where you can name your publication,
give it a motto, select the page layout, graphics,
and then select your news sources from a vast
array of publications, news media, by topic or
other criteria. Once you’ve made and saved all
your selections, log-in and click “Read My
Paper.” It will be assembled and presented to
you faster than you can holler, “Extra! Extra!
Read all about it!” If you’re a news junkie, be
sure to check out www.newser.com, also.

Q. When I click View > Details in a folder, is there
any way I can keep that view so I don’t have
to re-select the Details view again with the
next folder?

A. Theoretically, Windows will remember the View
selected for each folder and will display it the
same way each time the folder is opened. The
operative word in the previous sentence is
“theoretically.” Sometimes Windows remembers,
sometimes Windows doesn’t. I can relate.

You can encourage Windows to remember your
View settings by first configuring a folder the
way you want it to appear. Then, go to the
Control Panel > Folder Options > View tab. For
versions of Windows prior to XP, look at the list
of options in the Advanced Settings section and
locate “Remember each folder’s view Settings.”
Click to place a check mark in front of this
option, then click Apply > OK to save and exit.
XP users, click the “Apply to All Folders” button,
followed by Apply > OK. 

Vista users, go to the Control Panel >
Appearance and Personalization > Folder
Options > View tab and click the “Apply to
Folders” button. A less click-intensive method
with Vista is to click the Start button and in the
“Start Search” field, type “folder options.” Click
Folder Options when it appears as a search
result and you’ll be transported to the Folder
Options dialog box.

Q. I’m divorced, but my married name appears
in the From: field of email that I send using
Outlook.  I can’t figure out how to change the
name people see when I send messages. Can
you help, Mr. M?

A. You can easily change the name that identifies
you as the sender. The process is the same for
both Outlook and Outlook Express:  Click Tools
> Accounts > Mail tab.  If you have more than
one email address, you will see them displayed
in a list.  If you only have one, it will be the only
one displayed.  (When it comes to stating the
obvious, you can count on Mr. Modem.)   

Click to select the account you want to change,
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then click the Properties button. The current
name displayed on your email will appear in the
Name: field, which you can edit to reflect your
new name — or old name, as the case may be.
When you’re finished, click Apply > OK to save
your changes.   

Mr. Modem’s DME (Don’t Miss ‘Em)
Sites of the Month 

The American Roadside
This site is bumper-to-bumper full of entertaining
roadside attractions, interesting destinations along
scenic routes, and wonderful old “meat-loaf-and-
taters” diners. Read articles, view the photo gallery,
or buy books, t-shirts, and other American Roadside
paraphernalia, all destined to end up in your junk
drawer. www.theamericanroadside.com

About Big Numbers
Have you ever wondered how big an octovigintillion
is?  How about a tredecillion, or a quattuordecillion,

or a million-jillion, or perhaps a penicillin?  There are
so many big numbers here that you’ll have a splitting
headache in no time. http://tinyurl.com/yslq65

Brain Training
BrainMetrix advises us that when it comes to our
neurons, “use ‘em or lose ‘em.” To help keep the ol’
brain cells stimulated, BrainMetrix provides an
assortment of cerebral games and exercises that will
keep our minds sharp for… for… well, perhaps it’s
too late for me, but hopefully it won’t be for you.
Give your gray matter a vigorous workout by
participating in any of a number of these mind-
training exercises. http://brainmetrix.com

Mr. Modem’s weekly newsletter delivers helpful
computer tips, great Web sites and his personal
answers to your questions! Trial offer: Subscribe
online using Promo Code 1146 and receive one
free month with your 6-month subscription (28
issues!) To view a sample issue or subscribe, visit
www.MrModem.com.  
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History’s first recorded shorthand reporter was
Marcus Tullius, a freed Roman slave who became
Cicero's secretary. In 63 B.C., he used a metal stylus
to report a speech. Julius Caesar, a shorthand writer,
supposedly was stabbed with his own stylus. 

Shorthand later declined in popularity when it was
declared by the church to be necromantic and
diabolical. 

In 1588, Dr. Timothe Bright is credited with authoring
the first practical system of shorthand published in
English. Dedicated to Queen Elizabeth the First, the
system had no alphabet but consisted of more than
500 characters that had to be memorized. 

That system was later improved in 1750 by Thomas
Gurney, the first official reporter of parliamentary
debates in England. One of the most famous of these
“court reporters” was author Charles Dickens,
whose efforts to master shorthand became a subplot
in his book, “David Copperfield.”

In the United States, Thomas Jefferson and James
Madison used shorthand for diverse purposes. Using
personally developed shorthand, Madison recorded
the 1787 Constitutional Convention. 

But it is Isaac Pitman who is considered the father of
modern shorthand. In 1837, he developed the first
system of phonetically based shorthand in England.
His brother, Ben, later used the system to report the
trial of the assassin of President Lincoln. 

Irishman John Robert Gregg, in 1888, established his
own shorthand school. He moved to the U.S. in 1893
and established schools in Boston.

History of Shorthand
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